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What is PRISM? 

PRISM, Pitt’s Real-time Integrated Solutions for Management, is the University of Pittsburgh’s Enterprise 

Financial and Human Resources system. 

It is a comprehensive suite of web-based applications which provide innovative solutions to streamline 

university business processes and transactions. PRISM allows self-service access for faculty and staff to 

manage their personal data online from anywhere, such as benefits and address information. 

PRISM’s integrated applications include: 

• General Ledger (GL) 

• Purchasing (PO) 

• Accounts Payable (AP) 

• P-card Redistribution (PC) 

• Research Proposal & Accounting (RPA) 

• Human Resources (HR) 

• Payroll (PY) 

• Benefits (BEN) 

• Time Keeping & Entry (PRISM TRKS/PTE) 

Access 

PRISM access is granted upon submission of the relevant User Access Form. 

You can find the User Form and Instructions here: https://prism.pitt.edu/access  

Installing Java 

• You must have Java platform installed on your computer before you can use the professional 

applications within PRISM, Self-Service forms do not require Java. 

• This procedure needs to be done only once. Oracle releases periodic updates of Java, please 

verify the latest update version is supported in PRISM before updating your computer.  

• Unless you have full administrative rights to your computer, you must have someone from your 

tech support group install Java. 

  

https://prism.pitt.edu/access
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Follow the steps listed below to get directions for installing Java: 

1. Enter the following URL in your Browser: https://prism.pitt.edu , then click on the PRISM Access 

menu and select System Requirements. 

 

2. Here you will find all relevant information about PRISM System Requirements and versions. 

  

https://prism.pitt.edu/
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Log in to PRISM 

1. Navigate to the University Portal: https://my.pitt.edu  

 

2. Enter Username and Password. 

• If you have forgotten your password, click Forgot Password? to go to the University Self Service 

Password Reset option or contact the Technology Help Desk at 412-624-HELP (4357). 

• In order to use the self-service password reset, users must setup the designated security 

questions at http://accounts.pitt.edu/ 

3. Click the Submit button, then choose the secondary authentication method and log in. 

  

https://my.pitt.edu/
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4. On the My Pitt home page, search for PRISM in the search bar.  

 

You can add PRISM to your favorites by clicking the Heart Icon. 

5. The Oracle E-Business Suite home page will display your active responsibilities, worklist action items 

and favorites. 
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6. Your PRISM responsibilities are listed in the left-hand column under Main Menu. Notice each 

responsibility has a folder icon. 

 

7. Click on the plus signs to expand the folders and see the forms associated with that responsibility. 

8. Items that are expanded are preceded by a minus sign (-). You can expand no further when an item 

displays neither a plus or minus sign. (perhaps show the difference in icons for self-service vs. 

professional forms) 

9. There are two types of Forms in PRISM: 

Self Service 

Forms 

Ex: PHR Self Service, Time Entry, Time 

Off Balances 

Self Service Forms are marked 

with the following icon: 
 

Professional 

Forms 

Ex: Journal Entry, Reports Professional Forms are 

marked with the following 

icon:  

 

10. To open a form click on the form name, e.g., Enter Journals. (If it is a professional form, java web 

start will launch the professional form in a new window, SS will open directly) 

11. An fmsrvlet.jnlp file will start downloading. This file is part of Java Web Start and will trigger the 

opening of Java. Depending on the browser you use, you might get a warning message, like this one 

in Chrome: (The webstart would be better addressed in navigation and not in this part of the 

manual. If they were already in PRISM they could go to the navigator and open the form without 

this) 
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12. Select Keep, then open the file: 

 

Note: Depending on your browser and its settings, the file might be downloading automatically, or the 

browser might ask you to choose a location. Once the file is downloaded, open it, and PRISM will start as 

long as you have the right Java platform installed. 

You may also get the following message, select Run. 

 

13. Java will open. You will see the icon in your taskbar. 

14. The professional form will be now opened in the Java window 
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The Navigation List 

The navigation list is organized much like the hierarchy of a file system. You can expand items that begin 

with a plus sign (+) to further sublevels until you find the desired item. Sublevels appear indented below 

the items from which they are expanded. 

Items that are expanded are preceded by a minus sign (-). You can expand no further when an item 

displays neither a plus nor minus sign. 

Expanding the Navigation List 

Choose one of the following methods to expand an item to its next sublevel: 

• Double-click the item  

• Select the item, then click the Open button 
 

• Select the item, then click the Expand button 

 

Collapsing the Navigation List 

• To collapse an expanded item, Select the item, 

then click the Collapse button 

 

Expand and Collapse Several Items on the Navigation List 

To expand or collapse several items at once, choose one of the following buttons: 

• Expand Branch expands all the sublevels of the 

currently selected item 

 

• Expand All expands all the sublevels of all 

expandable items in the navigation list 

 

• Collapse All collapses all currently expanded 

items in the navigation list 

 

Opening a Form from the Navigation List 

There are several ways to open forms from the navigation list: 

1. Select the desired item, then click the Open button. 

2. Double-click on the desired item. 

3. Press the number that precedes the desired item. 
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Creating a Navigation Top-Ten List 

• If there are forms that you use frequently, you can copy them to a Navigation Top-Ten List 

located on the right side of the Navigator window. 

• The Navigation Top-Ten List displays your forms numerically so that you can choose them 

instantly without having to search for them in the navigation list. 

• Once the Top-Ten List is created, it will always be displayed when you go into the Navigator 

window. 

• You can place a maximum of ten items on the Top-Ten List 

• You can create a different Top-Ten List for each responsibility to which you have access. 

• A form can be deleted from the Top-Ten List at any time, simply by highlighting the item and 

then clicking on the Remove  button. 

• A Top-Ten List is unique for the responsibility and user sign-on combination that you use. 
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The Applications Toolbar 

 

The toolbar will be on the top of your screen. It is a list of shortcuts that replicate many commonly used 

menu items so you can invoke their actions quickly without having to search for them in the menu bar. 

Each toolbar button performs a specific action. Keep in mind, the toolbar buttons are always applied to 

the form that is selected at that time. Also, not all buttons will be available on every form. 

 
New Record Opens a new record in the active form (File → New) 

 
Find Opens a search window (View → Find) 

 
Show Navigator Returns to the Navigator window (View → Show Navigator) 

 
Save Saves any pending changes in the active form (File→Save) 

 
Next Step This feature does not work in this application 

 
Switch Responsibility Allows user to choose another responsibility when in the Navigator 

window 

 
Print Prints a copy of the active window (File → Print) 

 
Close Form Closes all windows in the active form (File→Close Form) 

 
Cut 

Removes the current selection and places it on the clipboard 

Edit→Cut) 

 
Copy Copies the current selection to the clipboard (Edit → Copy) 

 
Paste Pastes from the clipboard into a specified field (Edit → Paste) 

 
Clear Record 

Erases the current record from the active window (Edit 

→ Clear→ Record) 

 
Delete Deletes the current record from the database (Edit→Delete) 

 
Edit Field Displays the Editor window for the current field (Edit→Edit Field) 

 
Zoom This feature does not work in this application 

 
Translations This feature does not work in this application 

 
Attachments Opens the Attachments window (View/Attachments) 

 
Folder Tools Enables tools for folder adjustments (Folder/etc.) 

 
Window Help Displays general help for the active window (Help Window Help) 
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Keyboard Shortcuts 

Key Description Key Description 

F4 Close Window Ctrl S Save 

F5 Clear Field Ctrl Down Insert Record 

F6 Clear Record Ctrl Up Delete Record 

F8 Clear Form Tab Go to next field 

F11 Enter Query Shift Tab Go to previous field 

Ctrl/F11 Execute Query Shift PageUp Previous Block 

F4 Cancel Query or Close Window Shift F5 Duplicate Field Above 

Ctrl E Field Edit Shift F6 Duplicate Record Above 

Ctrl K List of Keys Shift Home Highlight Field 

Ctrl L List of Values (LOV) Shift End Highlight Field 

Button Shortcuts 

• Each button has a descriptive name displayed inside it with a specific letter underlined. To 

simulate clicking the button by using the keyboard, press the Alt key and the underlined letter 

found inside the button. For example: 

Alt O =  

Navigating Within a Form 

You can navigate within a form using one of the following methods: 

• Move the cursor with your mouse. 

• Choose an appropriate menu item. 

• Enter an appropriate keyboard shortcut. For example, pressing Tab or Enter. 

Difference between Tab and Enter: 

• Tab moves you between fields. 

• Enter accepts the default entry in the field or window, providing there is a default entry 

available. 

• If you use Enter to navigate between fields, you may get unexpected errors. Use Tab or your 

mouse as much as possible. 
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Field Colors: 

• Yellow fields – mandatory by the system, for example, the Batch name. 

• White fields – optional by the system but sometimes required by policy, for example, the control 

total. 

• Greyed out fields – Read only. 

Switching Responsibilities 

If you have several responsibilities and you want to work in Oracle Applications under a different 

responsibility, you can do so without exiting Oracle Applications. You must be in the Navigator window 

to switch responsibilities. 

To switch your responsibility: 

• Click on the Top Hat icon or select File/Switch Responsibility 

• Select a new responsibility from the Responsibilities window and click the OK button or double 

click on the desired responsibility. 

The Navigator window title and contents will reflect the new responsibility you have chosen. 

Closing a Form 

• In some forms, the initial window contains buttons that cause additional windows to be 

displayed. There are two ways to close windows within the applications. 

1. Select File from the menu bar, then select Close Form. 

2. Click the Close Window button that appears at the upper right hand corner of each active window. 

3. Use the Keyboard shortcut-- F4. 

4. Use the Close Form icon. 
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Exiting Oracle Applications 

1. Choose File -> Exit Oracle Applications.  

2. When exiting, if changes were made and not saved, a Decision box is displayed giving you the following 

choices: 

 

• Save - Save the changes before exiting 

• Cancel - Close this window and cancel the exit 

• Discard - Exit without saving any changes 

3. If there are no changes to save in your window or windows, a Caution pop-up box appears. 

 

4. Click OK if you are certain you want to exit, otherwise click on the Cancel button. 

5. Close all remaining windows until you return to the desktop. 
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Journal Components 

Every manually created journal consists of two major parts: 

• The Batch, which contains a single journal or a group of journals, with a mandatory batch 

control totals required for posting.  

• The Journal, which contains the header information, a journal control total for validation, the 

lines related to the transaction/s, and the preparer and approver information. Journals should 

not be created without a defined parent Batch. 

Journal Batches 

• The use of journal batches is required. 

• Batches can contain an unlimited number of journal entries. 

• All journal entries in a batch must share the same period and the same category. 

Transaction Types 

The transaction type will define the type of journal being entered. There are four major transaction 

types: 

NSCT - Non-Salary Cost Transfer 

Non-Salary Cost Transfers are used to correct erroneous transactions caused by data entry or other 

clerical errors. NSCTs may also be used in limited circumstances related to the transfer of expenditures 

held in a departmental expense account until a sponsored program (Entity 05) account is established or 

a final accounting is determined. NSCTs apply to all subcode categories except for series 5000-5999. 

Example: an incorrect account code was used during a purchase in Panther Express, or a P-card 

transaction was redistributed to the incorrect account, the cost can be transferred to the correct 

account. 

The transaction code for Non-Salary Cost Transfers is NSCT. An NSCT can be completed using the Enter 

Journal form in the GL Entry responsibility. 
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IDC - Inter Departmental Charge 

An Inter Departmental Charge is a journal transaction type restricted to authorized cost centers and 

certain other units to distribute the cost of goods and services provided to University departments on a 

recurring basis. 

Example: The Print Services department charges all other departments for printing services. 

Departments authorize the charge by submitting a printing request, which contains the relevant account 

numbers. Upon completion, the printing office creates an IDC to charge the requestor. 

The transaction code for Inter Departmental Charge is IDC. 

An IDC can be completed using the Enter Journal form within the assigned IDC responsibility. 

 

DDCR – Direct Deposit Cash Report 

A Direct Deposit Cash Report is a journal transaction type used to record revenue received by units 

through various methods authorized and approved by both the Controller and Officer of the Treasure 

(incudes deposits made directly to a University authorized banking institution).  

Example: The Athletics department sells tickets to a game. All cash that was paid for the tickets needs to 

be deposited to the bank account they have. The day this is completed, the department must enter a 

DDCR Journal entry to record the deposit. 

The transaction code for Direct Deposit Cash Report is DDCR. 

A DDCR can be completed using the Enter Journal form in the GL Cash Rpt responsibility.  

 

A detailed guide on how to complete DDCRs can be found here: 

https://www.controller.pitt.edu/general-accounting/policies-procedures-guidelines-

instructions/direct-deposits-and-credit-card-receipts/ 

  

https://www.controller.pitt.edu/general-accounting/policies-procedures-guidelines-instructions/direct-deposits-and-credit-card-receipts/
https://www.controller.pitt.edu/general-accounting/policies-procedures-guidelines-instructions/direct-deposits-and-credit-card-receipts/
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JE – Journal Entries 

The JE Type journal entry can be used for any entry other than the ones mentioned above. 

The Transaction code for a Journal Entry is JE.  

A JE can be completed using the Enter Journal form in the GL responsibility.  

 

A detailed guide on how to complete JEs can be found here: https://pre.prism.pitt.edu/wp-

content/uploads/Online-JE-Notification-6-6-19.pdf  

 

  

https://pre.prism.pitt.edu/wp-content/uploads/Online-JE-Notification-6-6-19.pdf
https://pre.prism.pitt.edu/wp-content/uploads/Online-JE-Notification-6-6-19.pdf
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Batch Name 

Each batch within an accounting period must have a unique name that conforms to the established 

batch naming conventions, specific for each transaction type. 

Transaction Code Department Number 3 Initials Date Entered Tracking Number (Optional) 

1. Transaction Code: the code of the transaction type detailed above 

2. Department Number: the preparer’s department number 

3. Initials: The initials of the person entering the journal (3 initials are required if available)  

4. Date Entered: The Date the journal is entered, in MM-DD or an acceptable and accurate format. 

5. Tracking Number: An Identifier in case more journals are entered the same day, or if they need 

special identifiers. The tracking number can be any unique numeric or alpha character 

Examples for each transaction type (note that Batch Names must be in UPPER CASE): 

• Non-Salary Cost Transfer: NSCT 49010 BAK 07-26-19 01 

• Inter-Departmental Charge: IDC 49010 BAK 07-26-19 01 

• Direct Deposit Cash Report: DDCR 49010 BAK 07-26-19 01 

• Journal Entries: JE GA BAK 07-26-19 01 

Please review this guide before creating a batch name: http://pre.prism.pitt.edu/wp-

content/uploads/Batch-Naming-Conventions-update-0525.pdf 

Batch Period 

• The batch period field defaults to the latest open period. 
• A batch can be created for any open or future–enterable period (future is only one month 

additional form current i.e. if SEP-19 is the current open period then OCT-19 is the only future). 
• An existing batch can also be updated for any open or future-enterable period as long as the 

batch is not posted. 
• All journals in a batch must be within the same period. 

Batch Control Total 

• Begin all batches with 1.00 in the BATCH control total to ensure premature posting and to 
signify that the batch has not been completed and still in progress.  

• A Control Total = 1 is required with the start of each batch and then changed to the 
proper total when the batch is completed and ready for posting. (Except procedures for 
cash reports) 

• When completed, the Batch Control Total must equal total debit = total credits for a batch. 

Example: 500.00 (total debits – 500.00 (total credits) = 500.00 (batch control total) PRISM verifies 
that the Batch Control Total equals the total of all entered bit anoints and the total of all entered 
credit amounts within the batch. 

• If there is a discrepancy, Oracle General Ledger displays a warning message before saving. 
• Batches, journals, and journal entry lines can be modified or deleted if the batch has not been 

posted.  

http://pre.prism.pitt.edu/wp-content/uploads/Batch-Naming-Conventions-update-0525.pdf
http://pre.prism.pitt.edu/wp-content/uploads/Batch-Naming-Conventions-update-0525.pdf


PRISM GL Department Administrator                                                           21 

Creating a Journal Batch – Non-Salary Cost Transfer 

1. To create an NSCT, log in to PRISM, and select the Journal Entry form in the GL responsibility. 

 

2. By default, you will see the following windows open: 
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3. Click on New Batch on the Find Journals form 

 

4. The Batch header opens. Enter the following details:  

• Enter the Batch name - for a Non-Salary Cost transfer, follow the required format in UPPER 

CASE: 

Transaction type Department Number 3 Initials Date Identifier 

NSCT 49010 BAK 07-29-19 01 

• The Period defaults to the current period. Be sure to select the proper available period for 

posting if necessary. 

• Enter the Description (optional). 

• Enter the BATCH Control Total: of 1.00 (one). This is required until all transactions within the 

batch are completed. Change the batch control total of 1.00 to the proper amount when the 

batch has been completed and approved and is ready for posting.  
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5. Click on Journals. 

 

6. The journal form opens. The required information on a Journal can be divided in three parts. 

Header information (1), Line items (2), and Preparer/Authorizer information (3). 
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7. Part 1 - Complete the Journal header information.  

• Enter the Journal name - The Journal name should reflect the department creating the journal 

entry. 

• Enter the Journal Description – should reflect the purpose of the entry This description becomes 

the default value in the Description field for each entry in the Line items section. If this 

information should not default to the line items, then complete this field after all line items have 

been entered. 

• The Ledger is always University of Pittsburgh. This is the default value. 

• The Category is always Journal. This is the default value. 

• The Period defaults form the Batch header and must match the period selected for the Batch. 

• The Effective Date defaults to the current date,  

• Enter the Control Total. The Journal Control Total equals to the total credits/debits of the line 

items. 
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8. Part 2 - Enter the Line items.  

• Enter a unique Line number. As a best practice, use 10 as the first identifier. This causes the 

system to enter the next line numbers automatically in increments of 10. This makes it easier to 

add lines between existing lines if necessary. 

• Enter the first Account. This can either be the debit or the credit account. You can type in the 

full account number, or if you enter the first two digits of the account entity and press [Tab], the 

system will automatically bring up the PITT_PRODUCTION COA window with zeros in the 

Reference and Unspecified fields.  

 

Note: for the full description of the university accounting code structure and explanation, visit this 

website: http://www.cfo.pitt.edu/ga/asas.html 

• Enter the debit or credit amount, depending on the account you entered first. 

• Update the description if necessary (defaulted from header) 

• Add additional lines. You must enter a minimum of two lines, one credit line and one debit 

line, and the dollar amounts total debits must equal total credits. (Note – if the entry is being 

completed by two separate departments, then total debit amount must equal total credit 

amount at the completion of the batch. 

  

http://www.cfo.pitt.edu/ga/asas.html
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• You can add additional Reference information on the Other Information tab. 

 

Credits Vs. Debits 

It is important to understand the role of credits and debits in actual journal entries (non-budget).  

• A Debit will always lower the balance on an account.  

• A Credit will always increase the balance on an account.  

Credits and Debits must always equal, meaning there must always be at least one credit and one debit 

line. 

In the example above, line 10 reflects the account currently charged (debited) in error. To move the 

charge to the proper account, line 10 will record the amount of the change as a credit amount. Line 20 

reflects the target account (the account that should have been charged (debited) for the purchased 

item. To complete the correcting transaction and move the charge to the proper account, line 20 will 

record the amount of the charge as a debit amount. 

TOTAL Debits = TOTAL Credits 

9. Part 3 - Complete the Journal – Journal Entries (Preparer/Authorizer) information. Click into the 

small flexfield found to the right of the Control Total field. 

 

10. A pop-up audit notification message will appear, asking you to ensure that the preparer and 

approver are two unique individuals and that the approver of this entry is the appropriate 

individual.  

You can review the related policy here: http://cfo.pitt.edu/policies/documents/policy05-06-

08.pdf  

 

http://cfo.pitt.edu/policies/documents/policy05-06-08.pdf
http://cfo.pitt.edu/policies/documents/policy05-06-08.pdf
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11. Enter the Preparer and Approver information, then click OK. (Note that Budget Entry must 

always be “NO”) 

 

12. Save your work! 

13. At this point, you should receive an error, notifying you that there is a batch control total 

violation. This is because the batch control total is still set to 1, but the journal control totals 

show the actual value. Select Save. If, however, you first receive an error prompt indicating a 

JOURNAL control total error, review your journal lines to determine and correct the error then 

save again. 

 

14. Close the journal window. In the batch header. If the batch has been approver and is ready for 

posting, then change the Batch Control Total to the proper amount (total debit amount = total 

credit amount = batch control total). Notice the batch header displays these. 

 

15. Save the batch. The batch will now be available for Budget & Financial Reporting to post the 

entry. Posting can occur within 1 – 3 days of release (this can vary) depending on schedules.  
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Multi-Line Journals 

A journal can contain many debit and credit lines.  

There are some cases when an NSCT can have multiple credit and debit lines.  Such as, if the correction 

is to be applied to multiple accounts or if multiple corrections are done within the same journal. 

 

In the example above, the transaction involves more than one entity. The system will automatically 

create “Intracompany balancing line” transactions to bring the entities into balance. 

You do not see the Intracompany lines the system adds because they do not impact departmental 

accounts, but the Total debit and total credit amounts will change along with the respective journal and 

batch control totals. You will see this when you query the batch.  

No actions are required by the user as the individual line items were recorded as entered. 
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Multi-Department Journals 

Journal entries that cross multi departments and are outside of the user’s security access, will require 

two users to complete, one from each department. 

The below method can only be used if all the following conditions are met: 

• Both the originating and target departments agree to the transaction 

• Both departments involved in the entry have PRISM online General Ledger entry access 

• The transaction is NOT part of an IDC or Cash Report 

• The transaction does not affect an account number designated for central or general university 

use 

If all of the conditions noted above are met and you are entering a transaction that affects a 

departmental (a university account number outside of those designated for Central or General 

university use.) account you do not have access to, the entry may be done online by adhering to the 

following procedure: 

Originating Department 

1. Create the appropriate batch in PRISM General Ledger (JE or NSCT) using the standard batch 

naming convention and placing a 1.00 in the BATCH control total (Steps 1-4) 

2. Enter the portion of the transaction affecting the originating department's account using line 

numbers between 1 and 49. (Steps 5-7) 

3. Enter the Preparer and Approver information of the originating department. (Steps 8-10) 

4. Save the batch. (Step 11-12) 

5. Notify the target department of the need for completion of the entry and provide the batch 

name that was created and any additional information as requested. 

6. 6) Upon notification of completion by the target department, change the batch control total to 

the proper amount for posting purposes.  

NOTE: It is the sole responsibility of the originating department to ensure that the batch is properly 

completed, and the batch control total is changed to the proper amount by the monthly cutoff date and 

time for the appropriate GL period. 

7. It is also the responsibility of the originating department to maintain all supporting 

documentation related to the full transaction according to record retention guidelines and to 

supply copies of this documentation to the Target Department if requested. 

 

  



PRISM GL Department Administrator                                                           31 

Target Department 

1. Open the entry in PRISM according to the batch name provided by the originating department. 

2. Enter the portion of the transaction affecting the target department’s account using line 

numbers between 50 and 99 on the SAME journal page within the batch. 

3. Save the batch. 

4. Notify the originating department upon completion of the entry. Note: The target department 

may request copies of supporting documentation from the originating department if needed. 

Proper Online General Ledger Batch Completion 

• The standards for proper online General Ledger Batch/Entry completion have not changed, 

however, as a reminder, the following standards are required: 

• Only proper Batch naming conventions will be accepted - this includes the three initials of the 

preparer if three are available  

• All Batches must begin with 1.00 in the Batch Control total and then must be changed to the 

proper control total upon completion – this is critical to the posting process 

• All Batches must be in balance when released for posting, e.g. 

DEBITS = CREDITS = BATCH CONTROL TOTAL 

• All Batches must be completed and released for posting to the appropriate period in accordance 

with the published monthly general ledger cutoff dates and times available at 

www.cfo.pitt.ecu/prism or www.cfo.pitt.edu/ga - departments are responsible for ensuring that 

their entries have been entered correctly and for the appropriate period and that they have 

been properly released for posting 

 

  

http://www.cfo.pitt.ecu/prism
http://www.cfo.pitt.edu/ga
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Creating a Journal Entry – Inter Departmental Charge 

Creating an IDC is the same process as creating an NSCT, with the following differences: 

• IDC replaces NSCT in the BATCH name 

• In an IDC journal the Reference field must contain the IDC authorization code issued to the 

department entering the IDC and the name of the issuing department (Example=D3 Panther 

Central) 

• The Debit lines are the department accounts being charged. Each department charge must have 

its own debit line 

• The Credit lines are the accounts associated with the recovery of costs 
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Creating a Journal Entry – Transfer Journals (826x subcode) 

Creating a JE with subcode 826x is the same process as creating an NSCT, with the following differences: 

• Use of subcode 826x is required for all accounts within the journal. 

• You will need to use the General Ledger “Transfer” responsibility to enter the transfer journals 

• The batch naming convention begins with JE and the remainder will be in the standard format 

(e.g. JE 02020 SRS 4-2) 

• In order to complete a split transfer journal online, both areas involved must have the General 

Ledger “Transfer” responsibility in PRISM, otherwise, the transfer should be completed on a 

paper journal entry form and submitted to Financial Records Services for processing. If both 

areas have the proper access, you can proceed with the multi-department entry. 

Refer to the following document to see the details on how to Create Transfer Journals: 

https://pre.prism.pitt.edu/wp-content/uploads/Transfers-826x.pdf  

https://pre.prism.pitt.edu/wp-content/uploads/Transfers-826x.pdf
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Querying and Updating a Batch/Journal 

On a monthly basis, check to ensure that all your journal entries for that period have been posted.  

Posting usually occurs within one to three days from release of the entry for posting. This will vary based 

on schedules. All batches properly completed and released for posting by the published cutoff date and 

time for that period and without error will be posted for the period entered. 

Check for the following: 

• Incorrect Batch names 

• Batch Control Total still contains a “1”, or Control Totals are missing 

• Incomplete Batches (Debits do not equal Credits) 

• Posting Status = “Error” 

To query for journal entries, follow these steps. 

1. There are two ways two inquiry a journal: from Entry and Inquiry modes. 

• Open the Enter Journals Form. By default, the Find Journals search form will open. If you query a 

batch/journal from the entry mode, you will be able to edit the journal 
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• Open the Journals form in the Inquiry folder. By default, the Find Journals search form will open. 

If you query a batch/journal from the inquiry mode, you will not be able to edit the journal 

 

2. Use the Enter Journals form. In the Find Journals screen, in the Batch field, enter “%Dept# 

Initials%”. The % is a wild card character that can stand for a single character, a group of 

characters, and blank spaces. Enter one blank space between Dept# and Initials. 

3. Enter the period for which you are querying journals, using the format MMM-YY. 

4. Click Find. 
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5. For each unposted Journal, review the Batch and Journals pages. Place your cursor on the 

desired journal line and then click on Review Batch 

 

6. Check the following: 

• Batch name - should be all upper-case characters and in the following format 

• “Type Dept Initials Date Tracking#” (only 1 space between each segment; no space before Type). 

• In case the period entered is no longer the current period, it needs updated. To change the 

Period, click on the Change Period button. 
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• Enter the new Period in the “To” field and click OK. 

 

• Note: For the Journal to be ready for posting, the Batch Control Total should equal Total Debits 

and Total Credits (except for Cash Reports, in which case the Batch Control Total should be “2”). 

 

• Click on the Journals button to open the Journal. Make sure the Control Total equals Debits and 

Credits 
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At this point, as long as the batch is “unposted” you can make any updates to this journal as necessary.  

• You can insert a line by clicking into an existing line, then clicking on the Insert Record button on 

the toolbar 

• Update both the Journal and Batch control totals accordingly. 

• Save the change 
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• Notice that the new line was inserted, and got the ID of 21, next available digit. Add the account 

code, the debit/credit, and ensure that the totals are equal. 
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• You can delete a line by clicking into the line you would like to delete and then clicking on the 

Delete button on the toolbar.  

• Update both the Journal and Batch control totals. 

• Save the change 

 

• Note: Be certain to make all necessary updates prior to the established cutoff dates and times 

published on the PRISM website, www.cfo.pitt.edu/prism. If additional assistance is needed, 

refer to Chapter 2 of the PRISM General Ledger training manual, or contact the Technology Help 

Desk at 624-HELP. 

  

http://www.cfo.pitt.edu/prism
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Deleting a Batch 

Note: Only Unposted batches can be deleted.  

1. Run a query on your Journals as above, place your cursor on the batch you would like to delete, 

and click Review Batch. 

 

2. Click ion the Batch name, to make sure it is highlighted then click the Delete button on the 

toolbar. 
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3. You will receive a warning message. Select Yes to delete the batch. 

 

4. Save your work! You will need to Save to confirm the deletion of the batch. 
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Reversing a Journal Entry 

Once the journal has been posted, it can no longer be deleted. If the transaction was entered by 

mistake, it can be reversed. 

• This process will mark the journal for automated reversal. The process will create a reversing 

journal entry of the original entry. You cannot select specific entries on a journal page for 

reversal. All entries on a journal page will be reversed. 

• You can choose to reverse a single journal or all journals within a batch. 

• You can reverse the journal to any open period or future entry period. 

• You can automatically reverse a journal only once. 

• You can reverse a reversing journal by the same method. 

Note: The system will create a batch beginning with “Reverse” followed by the journal name of the 

original journal page in quotes. 

1. Query the posted batch, then click on Review Journal. 

 

Note: If there are multiple journal pages within the batch, select the journal page/s you want to reverse 

by moving your cursor to the top of that page. 
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2. In the Reverse section on the top left side of the Journal, click into the Period field. 

 

3. You will receive a warning message. Click Ok. 

 

4. Enter the period in which you want the journal page to be reversed. 

 

5.  

6. You will be prompted again with the previous message. Click ok 

7. Save your changes. 

Note:  

• Only the preparer of the posted journal or an authorized individual from the preparer’s 

department can initiate/authorize an automated reversal of the journal. Central Administration 

may also initial the reversal if applicable in nature (If this action is needed, you will be notified.). 

• Enter the period in the Reverse window only if you want the journal page to be reversed. 

• Once you have marked a journal page to be reversed and saved the action, it will be generated 

and posted within the period you have selected, . (B&FR generates and posts the reversal) 
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Account Inquiry 

The Account Inquiry provides detailed information about a specific account number or range of account 

numbers for a specified period. 

• Does not show funds available 

• Shows posted entries only 

It also shows two balance types at once. 

• Actual 

• Budget 

It allows the review of journal entry details. 

• Drill down from account balances to journal entry detail 

• Review information for each journal entry line affecting the current account 

• Shows the effect of charges to the account 

1. Open the Account Inquiry form from the home page, or from the Navigator. 
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2. Select the From and To Accounting Periods. 

 

3. Click into the accounts field to enter the account number ranges. The unused segments can 

remain blank. Click OK (you can select 0000-9999 accordingly to get the entire range available 

within security). 
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4. The form will list all available accounts in the specified range within your assigned security. Your 

options are Show Balances, Show Journal Details, and Show Variance by individual accounts. 

First, select Show Balances. 

 

5. Show Balances shows the period to date and year to date balances for the periods specified. To 

see the journals for a period click into the period field, select Journal Details. 
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6. Show Journal Details shows the batches making up the balance for the specified period.  

• When the Source field says Payables you will be able to drilldown to invoicing and payment 

information. Select a journal, and click on Drilldown  

• Note, the drilldown option is not available for manual journal entries 

 

7. A new tab will open in your browser window. Here you can find more information on the 

expense. To see more details, click on the View Transaction button. 
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8. The Invoice Workbench will open in addition to general invoicing information, you can view the 

following: 

• Holds 

• Payments 

• Scheduled Payments 

• Prepayment Applications 

• Distributions 

 

  



PRISM GL Department Administrator                                                           51 

9. Click on View Payments to see the payment details. Here you will be able to see the Check 

Number (Document Num), the Payment Date, the GL Date and the Payment Amount. Click 

Payment Overview to see additional Payee and Invoice detail. 
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10. Close the Payment overview window, then click on the All Distributions button. 

 

11. Here you will see the distribution lines on the transaction. Scroll through the list to find the 

charge you are looking for. 
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Funds Inquiry 

View Funds Available allows review of: 

• Budget and actual amounts 

• Funds available for specific accounts 

• Drilldown to view associated journals or invoicing and payment information 

Funds available is your budget less any expenditures: 

Funds Available = Budget - Actuals 

View Funds Available provides immediate, up-to-the-minute financial information, and includes posted 

and unposted entries. 

1. Select the Funds form from the Home page or from the Navigator. 
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2. Fill out the header information 

The following are default values: 

• Ledger: University of Pittsburgh 

• Budget: University 

• Encumbrance Type: All 

• Account Level: All 

Populate the following fields: 

• Amount Type: 

• Year to Date Extended (Default) – Cumulative balances from the start date of the fiscal 

year until the specified period, including adjustment periods 

• Project to Date Extended - Cumulative balances from the start date of the account until 

the specified period, including adjustment periods 

• Period: Enter the current period 
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3. Click into the Account field and populate the account or the account range, then click OK. 

 

4. All available accounts will be populated form the range specified within your assigned security. 

For each account that displays, you can view a budget and actual amount and the resulting 

funds available. 
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5. To view more details, highlight an account, then select Tools/Period Balances from the toolbar.  

 

6. This option will show you a detailed balance for each period. Click into a period field, then select 

Tools/Actual Lines from the toolbar.  
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You will now see the transactions posted that month, if any. Select a transaction, then click Journal for 

manual GL transactions or Drilldown for Payable transactions. 

• For Payable transactions, the Source field will say “Payables” 

• For manually entered journals, the Source field will say “Manual” 

You can review the manual journal, or follow the steps from the Account Inquiry, and review the 

payable transaction details. 
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Standard Reports 

• Standard reports are pre-defined reports that allow you to review financial information 

• Users have access to specific reports based on their responsibility 

• Reports may run at any time and are submitted via the Submit Requests form 

• Users have the option of reviewing the output of a report online in addition to printing a hard 

copy of the output 

Commonly used Standard Reports: 

• Account Analysis - Lists the accumulated balances of a single account or a range of accounts and 

all journal entry lines that affect that range; cannot cross fiscal years 

• Budget- Journal by Account - Contains information about budget loads and modifications, by 

account numbers 

• Chart of Accounts - Provides information about the accounts in Pitt’s Chart of Accounts, 

including segment values, rollup ranges and suspense accounts 

• General Ledger - Lists the accumulated balances of a single account or a range of accounts and 

all journal entry lines that affect that range; can cross fiscal years 

• Journals-G– general report - Provides journal information including posted, unposted, and error 

journals. You can also review journal activity for particular periods and balancing segments. The 

Journals-General report will print out a hard copy of your journal entry 

Custom Reports 

Financial Statement Generator (FSG) - FSG’s are custom built reports that provide summary information 

(i.e. no transaction detail) for a specific period selected by the user. 

Refer to the following document for details on how to run FDG Reports: 

http://pre.prism.pitt.edu/wp-content/uploads/FSG-Department-User.pdf 

  

http://pre.prism.pitt.edu/wp-content/uploads/FSG-Department-User.pdf
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Running a Report 

1. To run a report, open the Submit a New Requests Form ->Other – Reports – Run 

Select the request type, then click OK. For GL, the Single Request type is most common.  

 

2. Click in the Name field. Select the Name of the report you want to run from the list of values, 

then click OK. 

 

Note: Your responsibility's request group determines which reports appear in the list.  
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3. The parameters window will appear. Define the Required Parameters (yellow) then click OK. 

Note: 

• Most requests require you to enter parameter values so you can specify the scope of 

information you want to see in the output. Prompts in the Parameters window are specific to 

the request you select. 

• Some parameter fields have a list of values available to ensure you choose a valid parameter 

value while other parameters are optional and require no value. 

• Default values may be predefined for one or more of the parameters associated with your 

request. Default values are automatically applied to these parameters when the Parameters 

window is opened. 

• The more parameters you define, the more narrow and specific the search will be. 
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4. Notice the defined parameters in the Parameters field. 

 

5. Click on Submit. 
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6. The Requests window opens, and notice that your request is pending. 

 

7. Click Refresh Data to see when your request is completed. 
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• The most recently run report will appear at the top of the list 

• Check the Phase field to see if the status is completed 

• If the report is still running, click on the Refresh Data button to refresh the screen until the 

Phase field says Completed 

8. Click on View Output button to view the report online once it completes running. 
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9. Review the report. 

• To view more of the report on the screen, change the font size 

• The vertical and horizontal scroll bars will move you through a page of your report 

• Use the button: Go To, First, Previous, Next, and Last to move through pages within the output  

• If you click Last and then look in the upper left-hand corner of the window, you will see 

the total number of pages in the report 

• If you have a printer setup for PRISM, printing a copy of the report will automatically be sent to 

the designated printer 
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10. You can print a hard copy of the report, while viewing the output, even if you have not set-up a 

printer for PRISM printing. Click on Tools -> Copy File. 

 

11. A copy of the report is opened up in another browser tab or window depending on your setup. 

From here, you can print the report. 
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Office of the Chief Financial Officer 

Please visit the Office of the CFOs website here: http://cfo.pitt.edu/ for additional financial resources. 

 

 

http://cfo.pitt.edu/
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PRISM Website 

Please visit the PRISM website for additional application information https://prism.pitt.edu/ 

Here you can find: 

• User Access Forms 

• System Requirements 

• Training Manuals 

• Training Demos 

• Quick Reference Guides 

• Contact Information 

 

 

 

 

https://prism.pitt.edu/

